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Chapter  2
 HUBwatch for OpenVMS Installation

___________________________________________________________________________

Overview
Introduction
This chapter describes how to install the HUBwatch for OpenVMS software by using the 
VMSINSTAL procedure.

In This Chapter
The chapter includes the following topics:

• Preinstallation requirements

• Preinstallation tasks

• VMSINSTAL overview

• Installing HUBwatch for OpenVMS

• Installation error messages

• Post-installation tasks

• Starting HUBwatch for OpenVMS as a standalone application

HUBwatch Software References
In this book, the term HUBwatch refers to the HUBwatch for Windows, HUBwatch for 
OpenVMS and HUBwatch for Digital UNIX software.
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Valid Configurations
 You can install the HUBwatch software in the following configurations.

• To run as a standalone application.

• To run HUBwatch as an application under POLYCENTER or DECmcc Version 1.2 
network management software. (Unless otherwise noted, further references to 
POLYCENTER also apply to DECmcc Version 1.2. 
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Preinstallation Requirements
Installation Time 
On OpenVMS VAX systems, the HUBwatch software installation procedure takes 
approximately 10 minutes. If you are running the DEC TCP/IP Services for OpenVMS VAX, 
you may need more time 

DEC TCP/IP Services for OpenVMS Information: See “Set Up DEC TCP/IP Services for 
OpenVMS VAX”  in this chapter for information about using it with HUBwatch.

Hardware Requirements
For a list of VAXstations that are compatible with HUBwatch, refer to the HUBwatch for 
OpenVMS VAX Software Product Description (SPD 45.74.10-XX).

Software Requirements
The system must have the following software installed and operating:

• OpenVMS VAX operating system Version 6.0 or later

• DECwindows Motif Version 1.2 or later 

• OpenVMS DECwindows Motif Bookreader Version 4.0 or later 

• DEC TCP/IP Services for OpenVMS VAX Version 2.0 or later, or TGV MultiNet 
Version 3.2 or later

To verify that you have the DEC TCP/IP Services for OpenVMS software, type UCX at the 
system prompt. The UCX prompt appears (UCX>). Press Ctrl/Z to return to the system 
prompt.
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Verifying Product Version Numbers: Complete the following steps to verify your product 
version numbers.

Optional Software
To use HUBwatch with the POLYCENTER network management platform, you must have one 
of the following products installed:

• POLYCENTER Framework Version 1.3 or later

• POLYCENTER Network Manager 200 Version 1.3

• POLYCENTER Network Manager 400 Version 2.3

• DECmcc Director Version 1.2

• DECmcc Basic Management System Version 1.2

• DECmcc Enterprise Management Station Version 2.2

For This Product... Enter This Command...

OpenVMS VAX 
software

$SHOW SYSTEM

Result: The version appears in the first line of output.

DECwindows 
Motif 

From the Session Manager window, click on the Help menu and 
choose On Version.

OpenVMS  
DECwindows 
Motif 
Bookreader 

From the Help menu, select Product Information.

DEC TCP/IP 
Services for 
OpenVMS

$UCX

UCX> SHOW VERSION

TGV MultiNet $MULTINET SHOW/VERSION
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Firmware Requirements
Each of your hubs and modules needs the most recently released version of the firmware. See 
the HUBwatch release notes for the minimum revision firmware that HUBwatch supports.

Because Digital is continuously improving the quality of the DEChub product family, periodic 
releases of firmware will become available. To find information about the latest firmware 
releases:

• Contact your local Digital reseller or your local Digital sales office. 

• Read the README file found in the /pub/DEC/hub900 directory at ftp.digital.com.

Firmware updates are customer installable. To register for automatic notification of new 
firmware releases, return the business reply card supplied with this product, or send your name, 
title, and mailing address to dechub_notice@lkg.dec.com.

Memory Requirements
See the HUBwatch Software Product Description (SPD) for the recommended minimum 
memory requirements for HUBwatch. See the HUBwatch release notes for virtual memory 
requirements. 

Complete the following steps to check available memory, global sections, and global pages.

Disk Space Requirements
See the HUBwatch release notes for the recommended minimum disk space for HUBwatch. 
Make sure that you have enough free blocks on the system disk. If you do not have enough free 
blocks, the installation fails.

Finding Free Block Amount: To find out how many free blocks exist on the system disk, enter:

$ SHOW DEVICE SYS$SYSDEVICE: 

If the number of required blocks exceeds the number of free blocks, clear space on the system 
disk.

To Check... Enter This Command...

System memory$ SHOW MEM

Global sections $ WRITE SYS$OUTPUT F$GETSYI ("FREE_GBLSECTS")

Global pages $ WRITE SYS$OUTPUT F$GETSYI ("FREE_GBLPAGES")



Preinstallation Requirements

 2-6 HUBwatch for OpenVMS Installation

Account Privileges and Quotas
See the HUBwatch release notes for the recommended process quotas and SYSGEN parameter 
values. You need system privileges for the account from which you plan to install HUBwatch 
to change system parameters.

Complete the following commands to view and change these values. 

To See Current... Enter These Commands... And Change Values with These 
Commands...

System privileges $ SHOW PROCESS /PRIVILEGES $ SET PROCESS/PRIV=ALL

Process quotas $ SET DEFAULT SYS$SYSTEM
$ RUN SYS$SYSTEM:AUTHORIZE 
UAF> SHOW

If you do not have the required 
quotas, 
enter:
UAF> MODIFY user-name - 
_UAF> /quota-name=value 

Press Ctrl/Z to return to the system 
prompt. You must log out and log 
in again for the new values to take 
effect.

SYSGEN 
parameters

$ SET DEFAULT SYS$SYSTEM 
$ RUN SYS$SYSTEM:SYSGEN 
SYSGEN> SHOW /ALL 

SYSGEN> SET param-name -
_SYSGEN> value
SYSGEN> WRITE CURRENT

Press Ctrl/Z to return to the system 
prompt. You must reboot the 
system for the new values to take 
effect.
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Preinstallation Tasks
Introduction
This section describes the tasks you perform before you start the installation procedure.

Read the Release Notes
A number of installation requirements might not be known exactly until after this book is 
printed. The HUBwatch release notes list those requirements. Do not install HUBwatch unless 
your system satisfies those requirements.“Read the Release Notes”  in “Installing HUBwatch 
for OpenVMS”  explains how to install and print the release notes. Be sure to read them before 
completing the HUBwatch installation.

Requirements in Release Notes: The installation requirements listed in the release notes 
include minimum values for the following:

• Disk space

• Process quotas

• SYSGEN parameters

• Virtual memory

For POLYCENTER Users: If you plan to run HUBwatch as an add-on application to 
POLYCENTER, you must use the minimum values required for POLYCENTER if they are 
higher than those listed in the HUBwatch Release Notes. Refer to the POLYCENTER 
documentation. (Unless otherwise noted, further references to POLYCENTER also apply to 
DECmcc.)

Is the Distribution Kit Complete?
The HUBwatch installation kit should contain the following items:

• One TK50 tape cartridge labeled HUBWAT

• HUBwatch Installation and Configuration book (this book)

• HUBwatch Use book

If any item is missing, contact your local Digital representative.
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Back Up the System Disk
Before starting the installation procedure, back up the disk onto which you will install the 
HUBwatch software. Use the following command to back up the disk.

$ BACKUP/IMAGE/VERIFY/LOG SYS$SYSDEVICE:[*...]*.*;* - 
_$ backup-device :SYSTEM.SAV /SAVE

Command Variable: The backup-device variable is the device to which you are copying the 
HUBwatch files.

Install the HUBwatch License
You cannot use HUBwatch software unless the HUBwatch license is installed. To check for the 
HUBwatch license, type:

$ SHOW LIC HUBWATCH 

Installing the License: If the license is installed, see Installing HUBwatch in this chapter. 
Complete the following steps if the license is not installed.

Set Up DEC TCP/IP Services for OpenVMS VAX 
If you are running DEC TCP/IP Services for OpenVMS VAX, enter the following OpenVMS 
commands before installing HUBwatch.

$ create sys$sysdevice:[ucx$snmp]ucx$snmp.log
<Ctrl/Z>
$ set file /version_limit=5 sys$sysdevice:[ucx$snmp]ucx$snmp.log
$ purge sys$sysdevice:[ucx$snmp]*.log

Purge Time: If you have a large number of log files, the purge command might take up to an 
hour to execute.

Step Action

1 Obtain the HUBwatch Product Authorization Key (PAK) delivered with 
the software distribution kit.

2 Log in to the system account.

3 Enter the following command to start the OpenVMS VAX license 
command procedure:
$ @SYS$UPDATE:VMSLICENSE.COM 

4 In response to the prompts, enter the information from the PAK.
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VMSINSTAL Overview
Introduction
VMSINSTAL is an interactive procedure that displays a series of questions. You use the 
VMSINSTAL command procedure to install the HUBwatch software on an OpenVMS VAX 
system. This procedure copies files from the distribution media to the installation disk.

Additional Information: See the OpenVMS/VAX documentation for a complete description 
of VMSINSTAL. See to the HUBwatch release notes for a list of files and logical names that 
the HUBwatch installation procedure adds or modifies.

VMSINSTAL Guidelines
Basic guidelines for using VMSINSTAL are as follows:

• After each question, the default response, if there is one, appears in brackets ([ ]). At the 
end of each question, either a colon (:) or a question mark (?) appears. Respond in one of 
the following ways.

− To get help after a question, type a question mark (?). After the help display, the same 
question reappears.

− To select the default response, press Return.

− To enter information, type it immediately after the colon or question mark, and press 
Return.

You can type Y for Yes and N for No.

• To abort the installation procedure at any time, press Ctrl/Y.

The installation procedure deletes all files that it has created up to that point and returns to 
the Digital Command Language (DCL) level. Invoke VMSINSTAL again to restart the 
installation procedure.
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Installing HUBwatch for OpenVMS
Installing HUBwatch for OpenVMS involves nine tasks. 

1. Starting the procedure.

2. Confirming system disk backup.

3. Reading the release notes.

4. Do you want to run the IVP?

5. Purging files

6. Answering HUBwatch-specific questions.

7. Reading installation messages.

8. Proving SNMP information

9. Running the IVP.

Task 1: Starting the Procedure
Complete the following steps to start the HUBwatch installation procedure.

Step Action

1 Log in to the system account.
Result: The system prompt appears.

2 Mount the HUBwatch distribution tape on the tape drive. For instructions 
about mounting and removing a TK50 tape cartridge, see the system 
documentation.
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Step Action

3 Start VMSINSTAL with the following command.
$ @SYS$UPDATE:VMSINSTAL HUBWATCH device-name : OPTIONS N  

Command Variables: The VMSINSTAL command variables are as 
follows.
• HUBWATCH names the save set on the distribution media.

• device-name: names the device where the distribution media is 
mounted (for example, MKB300:).

• OPTIONS N provides the option of printing the on-line HUBwatch 
release notes. If you are reinstalling the same version of HUBwatch 
software and you have already read the release notes, you can omit 
OPTIONS N.

Result: The procedure displays the following.
VAX/VMS Software Product Installation Procedure 
Version n.n.

It is dd-mmm-yyyy at hh:mm.
Enter a question mark (?) at any time for help.
The procedure displays a message like the following 
to tell you what processes are active on your 
system.
%VMSINSTAL-W-ACTIVE, The following processes are still 
active:

     DAVID

     DECW$TE_0118

     DINANT

     DECW$BANNER

     DECW$MWM

     NML_8299

* Do you want to continue anyway [NO]?

4 Type yes and press Return.
Result: The procedure continues; go to Task 2: Confirming System Disk 
Backup.
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Task 2: Confirming System Disk Backup
The procedure displays the following message:

* Are you satisfied with the backup of your system disk [YES]?

Do one of the following:

• If you are not satisfied with the backup, type N and press Return to terminate the 
installation procedure. Back up your system disk and reenter the VMSINSTAL command:

$ @SYS$UPDATE:VMSINSTAL HUBWATCH device-name : OPTIONS 

If you stop the procedure to back up the system disk and then restart the procedure, the 
procedure displays the introductory prompts. 

• If your system disk is fully backed up, press Return to answer Yes. The procedure 
continues; go to Task 3: Reading the Release Notes.

Task 3: Reading the Release Notes
After you confirm the system backup status, the procedure displays the following messages:

The following products will be processed:

HUBWATCH Version 4.1

                 Beginning installation of HUBWATCH Version 4.1 at 09:15

%VMSINSTAL-I-RESTORE, Restoring product saveset A. . .

If you include OPTIONS N in the VMSINSTAL command, the procedure shows these options. 

Release notes included with this kit are always copied to SYS$HELP. 
Additional Release Notes Options:

 1. Display release notes

 2. Print release notes

 3. Both 1 and 2

 4. None of the above

* Select option [2]:* 

Queue name [SYS$PRINT]:

Complete the following steps to select a release note option
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.

Task 4: Do You Want To Run the IVP?
The installation verification procedure (IVP) verifies that all files from the distribution kit are 
in the proper directories, that the release notes are in the SYS$HELP directory, and that the 
HUBwatch software can be started.

After you select the release notes option, the procedure displays the following prompt:

* Do you want to run the IVP after the installation [YES]

Type yes and press Return if you want the IVP to run automatically. The installation procedure 
will start the IVP after all other tasks are complete (see Task 8: Provide SNMP Information). If 
you prefer to start the IVP manually, see Post-Installation Tasks in this chapter.

Step Action

1 Select the release note option you want.
Result: The procedure displays the following message:
* Do you want to continue the installation [NO]?

2 Type Yes and press Return.
Result: The following messages appear:
%VMSINSTAL I - RELMOVED, The product's release notes have 
been moved to SYS$HELP

-------------------------------------------------------
HUBwatch for OpenVMS for VAX - Version 4.1
VMSINSTAL installation procedure
Copyright „  1995  by

DIGITAL EQUIPMENT CORPORATION, Littleton Mass, USA
All rights reserved

-----------------------------------------------------
-       Product:          HUBWATCH

        Producer:         DEC

        Version           4.1

        Release Date:

* Does this product have an authorization key registered and loaded?

3 Type Yes and press Return.
Result: The procedure continues; go to Task 4: Do You Want to Run the 
IVP?.
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Task 5: Purging Files
When the procedure continues, it displays the following prompt:

* Do you want to purge files replaced by this installation [YES]?

Press Return to answer Yes. The procedure continues with HUBwatch-specific questions; go to 
Task 6: Answering HUBwatch-Specific Questions.

Task 6: Answering HUBwatch-Specific Questions
The procedure displays the following messages:

The logical name HUBWATCH$LIBRARY should be defined as the directory 
which contains or which will contain the HUBwatch agents file and the 
HUBwatch events agents file.

SYS$STARTUP:HUBWATCH$STARTUP.COM will define the system-wide logical 
name HUBWATCH$LIBRARY as SYS$LOGIN. To assign a different system-wide 
translation for HUBWATCH$LIBRARY, enter it below. You may also edit 
SYS$STARTUP:HUBWATCH$STARTUP.COM at a later time.

* System-wide translation for HUBWATCH$LIBRARY: [SYS$LOGIN]:

Complete the following steps to answer the installation questions.

Step Action

1 Do one of the following:

• Press Return to accept the default translation for 
HUBWATCH$LIBRARY. 

• Enter a different translation and press Return.

Result: The procedure displays the following information:

The logical name HUBWATCH$ALARM_FILES may be 
defined as the directory which will be used for 
HUBwatch event polling and alarm logfiles.
SYS$STARTUP:HUBWATCH$STARTUP.COM will define the 
system-wide logical name HUBWATCH$ALARM_FILES as 
SYS$SYSTEM. To assign a different system-wide 
translation for HUBWATCH$ALARM_FILES enter it 
below. You may also edit 
SYS$STARTUP:HUBWATCH$STARTUP.COM at a later time.
* System-wide translation for 
HUBWATCH$ALARM_FILES:  [SYS$SYSTEM]:
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Step Action

2 Do one of the following:

• Press Return to accept the default translation for 
HUBWATCH$ALARM_FILES.

• Enter a different translation and press Return.

Result: The procedure then displays the following information:

he HUBwatch poller is a background process that 
queries a list of DEChubs and DEChub modules for 
selected MIB information. This 
information is then used by the HUBwatch alarms 
component.  The poller may be started manually at 
any time by using the
WATCH /POLLER START [/FILE=<alarm_agents_file>]
DCL command, or it may be started automatically in 
the HUBwatch system startup procedure 
SYS$STARTUP:HUBWATCH$STARTUP.COM.
* Automatically start the HUBwatch poller?(YES|NO)   [YES]
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Step Action

3 Do one of the following:

• Press Return if you want to start the poller automatically when you 
start HUBwatch. 

• Enter No and press Return if you do not want the poller started auto-
matically. If you enter No, you can start the poller later by entering the 
command

   $ WATCH /POLLER START [/FILE=alarm-agents-file]

Result: If you chose to start the poller automatically, the procedure 
displays the following messages.

The HUBwatch poller reads agent information from a 
file. If the poller is interactively invoked 
through the WATCH/POLLER START 
command, and an alarmed agents file is not 
specified, then it will use 
HUBWATCH$LIBRARY:HUBWATCH_ALARMED_AGENTS.DAT. 
When the poller is invoked through 
HUBWATCH$STARTUP.COM, it uses the SYS$MANAGER 
directory.
To use a different filename, enter it below. You 
may also edit 
SYS$STARTUP:HUBWATCH$STARTUP.COM at a later time.
* HUBwatch poller agents 
file:[SYS$MANAGER:HUBWATCH_ALARMED_AGENTS.DAT
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Task 7: Reading Installation Messages
The procedure  displays the following informational messages for you to read:

%HUBWATCH-I-NOMOREQUES, No more questions will be asked
during the installation phase.
%HUBWATCH-I-COMPTIME, HUBwatch installation will typically
complete in about 5 minutes.

Step Action

4 Do one of the following:
• Press Return to accept the default file name. 
• Enter a different file name and press Return.
Result: If you are running a version of OpenVMS prior to Version 6.0, the 
procedure displays a message similar to the following:

ATTENTION SYSTEM MANAGER:

After HUBwatch installation completes, you must add    
the following line to SYS$MANAGER:SYSTARTUP_V5.COM

    $ @SYS$STARTUP:HUBWATCH$STARTUP.COM      

If you are running OpenVMS Version 6.0 or later, the procedure displays 
a message similar to the following:
ATTENTION SYSTEM MANAGER:

After HUBwatch installation completes, you must add the 
following line to SYS$MANAGER:SYSTARTUP_VMS.COM

$ @SYS$STARTUP:HUBWATCH$STARTUP.COM

The procedure then displays a message similar to the following and pauses:

ATTENTION HUBwatch USERS: 

If HUBwatch Version 2.0 or earlier is in use at this site,
users should make a backup copy of their agents file

before running HUBwatch Version 4.1.
HUBwatch Version 4.1 will automatically convert agents 
files into a new format. However, this new format is 
not compatible with pre-Version 3.0 versions of HUBwatch.

* Press <Return> to continue.

5 Press Return.
Result: The procedure continues; go to Task 7: Reading Installation 
Messages.
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%VMSINSTAL-I-RESTORE, Restoring product save set B ...

%HUBWATCH-I-FILES, Copying image file...

%HUBWATCH-I-FILES, Copying message, option files..., and data files...

%HUBWATCH-I-FILES, Copying command procedures

%HUBWATCH-I-FILES, Copying help files and documentation 

%HUBWATCH-I-FILES, Creating customized HUBwatch startup procedure...

questionnaire...

%VMSINSTAL-I-RESTORE, Restoring product save set C

%HUBWATCH-I-FILES, Copying DECwindows UID files...

        If any users on the system are using HELP right now,

        the installation will be delayed for up to 5 minutes.

  ...  HUBwatch HELP installed.

If the POLYCENTER or DECmcc network management application is installed on your 
system, the procedure displays the following messages:

To launch HUBwatch from DECmcc version 1.2, all DECmcc users

  need to modify their own MCC_RESOURCE.DAT file according

  to the instructions in MCC_SYSTEM:MCC_HUBWATCH.COM.

DECmcc version 1.3 users will be able to launch HUBwatch

  directly from DECmcc's Applications menu with no other

  changes necessary.

The procedure then displays this message:

%VMSINSTAL-I-MOVEFILES, Files will now be moved to their target directories...

-------------------------------------------------------

HUBwatch for OpenVMS for VAX, Version 4.1

Installation verification procedure.

Copyright © 1995 by

DIGITAL EQUIPMENT CORPORATION, Littleton, Mass, USA

All rights reserved.

------------------------------------------------------
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Task 8: Providing SNMP Information
The procedure then prompts you to provide SNMP information. The procedure displays the 
following message:

Enter a question mark (?) for help on any of the following questions

or type <Ctrl/Z> to exit the verification procedure at any time.

*  What is the IP address of the SNMP agent?

Complete the following steps to supply the SNMP information.

Task 9: Running the IVP
When the procedure starts the IVP, it displays the following messages:

Device:    WSA1:  [exec]

Node:      0

Transport: LOCAL

Server:    0

Screen:    0

HUBwatch will now be run on the above display. 
When the front-panel view for your hub comes up, move the 
   pointer to the `File` menu, and press and hold mouse
   button 1.  Slide the pointer down to `Exit` in the menu
      which will appear below File, and release mouse button 1.

If HUBwatch fails to come up, check that the display
   information shown above is correct...

* Hit the <Return> key to start HUBwatch or <Ctrl/z> to abort:

Step Action

1 Enter the IP address in the format n.n.n.n, where n is a decimal number less 
than 256. Then press Return.
Result: The procedure displays the following message.
* What is the r/w Community Name for the agent [public]?

2 Press Return to use the default name public,  or enter the community 
name of the agent and press Return. The community name is case sensitive.
Result: The procedure continues with the IVP if you specified this in task 
4 of the installation procedure. If you did not so specify, the installation 
procedure completes.
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Complete the following steps to run the IVP.

Step Action

1 Press Return.
Result: The procedure continues by starting HUBwatch. HUBwatch 
begins by displaying hub management and configuration information.
Example: 
WATCH /AGENT 00.00.00.00 -

      /COMMUNITY="public" -

      /TIMEOUT=5 /RETRIES=2 /VIEW=PHYSICAL

(I) HUBWATCH$LIBRARY = SYS$LOGIN

Result: The procedure displays the following.
HUBwatch for OpenVMS Revision 4.1

If you have not previously installed and used HUBwatch, you receive 
warning messages like the following (which you can ignore):
(W) Current agent not in the agent table
(W) Unresolved agent node IP name
(W) Agent type DETMM found for 00.00.00.00

As part of the IVP, HUBwatch software displays the Hub front panel 
window. The Hub front panel window differs, depending on whether you 
started HUBwatch with the IP address of a DEChub 900 MultiSwitch 
(MS), a DECagent 90, a GIGAswitch, or a standalone module. The 
HUBwatch Use book has pictures of the Hub front panel windows that 
appear for the DEChub 900MS and the DECagent 90.

2 Exit the Hub front panel window. Click on the File menu and then click on 
Exit.
Result: The procedure displays the following.
The HUBwatch events viewer will now be verified. 
When the HUBwatch viewer window appears on the display, 
move the pointer to the `File` menu, and press and hold 
mouse button 1. Slide the pointer down to `Exit` in the 
menu which will appear below File, and release mouse but-
ton 1.

*   Hit the <Return> key to start the events viewer, or 
<ctrl/z> to abort:   

$   WATCH /VIEWER

3 Press Return to verify the events viewer.
Result: The HUBwatch software displays the Events Viewer window.
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Step Action

4 Exit the Events Viewer window. Click on the File menu and then click on 
Exit.
Result: The procedure completes and displays the following messages.

Exiting HUBwatch

HUBwatch Version 4.1 Installation verification complete.

      Installation of HUBWATCH V4.1 completed at 09:58

      VMSINSTAL procedure done at 09:58
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Installation Error Messages
Introduction
This section lists error messages specific to HUBwatch that you may receive while installing 
the application. Each message in this section is followed by an explanation and a recommended 
user action.

HUBWATCH-E-BADVMSVER
Message Text: HUBWATCH-E-BADVMSVER, This kit requires version 6.0 
or later of OpenVMS VAX.

Explanation: Your version of OpenVMS VAX is too low.

User Action: Install OpenVMS VAX Version 6.0 or later before installing HUBwatch.

HUBWATCH-E-INSGBLPGS
Message Text: HUBWATCH-E-INSGBLPGS, Insufficient global pages.  
HUBwatch needs at least nnn  free global pages.

HUBWATCH-I-CURGBLPGS, Only nn global pages are available.

Explanation: You do not have the minimum required global pages as specified in the release 
notes for the HUBwatch installation.

User Action: Increase the SYSGEN GBLPAGES parameter and reboot the system before 
installing HUBwatch. Increase the GBLPAGES by at least the current value plus the number 
listed in the release notes.

HUBWATCH-E-INSGBLSCT
Message Text:: HUBWATCH-E-INSGBLSCT, Insufficient global sections.  
HUBwatch needs at least nn free global sections.

HUBWATCH-I-CURGBLSCT, Only nn global sections are available.

Explanation: You do not have sufficient available global sections to install HUBwatch.

User Action: Increase the SYSGEN GBLSECTIONS parameter to at least the number listed in 
the release notes, and reboot the system before you install HUBwatch.
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HUBWATCH-E-INSSYSSPC
Message Text: HUBWATCH-E-INSSYSSPC, Insufficient space on system 
disk to install HUBwatch.

HUBWATCH-I-TOTSYSSPC, nnn ,000 blocks are needed.

Explanation: You do not have sufficient free blocks on the system disk to install HUBwatch.

User Action: Clear enough space on the system disk before you install HUBwatch (see the 
release notes for disk requirements).

HUBWATCH-E-UCXNOTFOUND
Message Text: UCX$IPC_SHR.EXE network software not found on system.

HUBWATCH-I-UCXREQ, Either DEC TCP/IP Services for OpenVMS (UCX) or TGV 
MultiNet is prerequisite software for HUBwatch.

Explanation: Prerequisite software, DEC TCP/IP Services for OpenVMS VAX, is not installed 
on the system.

User Action: Install DEC TCP/IP Services for OpenVMS VAX before you install HUBwatch 
(see Software Requirements in this chapter).

HUBWATCH-W-ERRMCC
Message Text: HUBWATCH-W-ERRMCC, Error copying DECmcc launch files 
to MCC_COMMON:

Explanation: HUBwatch detected that POLYCENTER or DECmcc was installed on the 
system, but it could not copy the HUBwatch launch files (MCC_HUBWATCH.COM and 
MCC_APPL_HUBWATCH.DEF) to the MCC_COMMON directory. Instead, HUBwatch 
copied those files to the SYS$LIBRARY: directory.

User Action: At a later time, copy those files to the MCC_COMMON directory.

HUBWATCH-W-HELPINUSE

Message Text: HUBWATCH-W-HELPINUSE, System HELP library in use. HUBwatch help 
not installed.

Explanation: An individual is using OpenVMS Help; therefore, the installation procedure 
cannot add HUBwatch Help to the OpenVMS Help library at this time.

User Action: Add help for the HUBwatch startup command, WATCH/AGENT, at a later time. 
Use the following command:

$ LIBRARY /REPLACE /HELP SYS$HELP:HELPLIB SYS$HELP:HUBWATCH.HLP
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Post-Installation Tasks
Introduction
This section describes the four post-installation tasks:

1. Running the IVP separately.

2. Installing HUBwatch files separately.

3. Editing the system startup command procedure.

4. Modifying DECmcc Version 1.2 files

About the IVP
If you did not select to run the installation verification procedure (IVP) when installing 
HUBwatch, you must run it before using HUBwatch to verify that the software is ready. You 
can also run the IVP after a system failure to ensure that HUBwatch is still ready.

IVP Failure: If the IVP fails, run it again. If it still fails, contact your Digital representative.

Task 1: Running the IVP Separately
Complete the following steps to run the IVP separately from the installation procedure.

Step Action

1 Enter the following command:
$ @SYS$TEST:HUBWATCH$IVP

Result: The following messages appear:
-----------------------------------------------------------------

HUBwatch for OpenVMS for VAX, Version 4.1
Installation verification procedure.

Copyright © 1995 by
DIGITAL EQUIPMENT CORPORATION, Littleton, Mass, 
USA

All rights reserved.
-----------------------------------------------------------------

Enter a question mark (?) for help on any of the following 
questions,  or type <CTRL/Z> to exit the verification 
procedure at any time.

*  What is the IP address of the SNMP agent?
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Step Action

2 Enter the IP address in the format n.n.n.n, where n is a decimal number less 
than 256. Then press Return.
Result: The procedure displays the following:
*  What is the r/w Community Name for the agent?

3 Enter the community name for the agent, (for example, “public”). The 
community name is case sensitive.
Result: The procedure displays the following:
*  Hit the <Return> key to start HUBwatch or <ctrl/z> to 
abort :

4 Press Return to start HUBwatch.
Result: The procedure displays the following:
Device:    WSA1:  [exec]

Node:      0

Transport: LOCAL

Server:    0

Screen:    0

HUBwatch will now be run on the above display. 
When the front-panel view for your hub comes up, 
move the pointer to the ̀ File` menu, and press and 
hold mouse  button 1. Slide the pointer down to 
`Exit` in the menu which will appear below File, 
and release mouse button 1.
If HUBwatch fails to come up, check that the display 
information shown above is correct...

*  Hit the <Return> key to start HUBwatch or  <ctrl/z> 
    to abort:
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Step Action

5 Press Return.
Result: The procedure then continues by starting HUBwatch. HUBwatch 
begins by displaying hub management and configuration information.
Example: 
WATCH /AGENT 00.00.00.00 -

      /COMMUNITY="public" -

      /TIMEOUT=5 /RETRIES=2 /VIEW=PHYSICAL

 (I) HUBWATCH$LIBRARY = SYS$LOGIN

The procedure then displays the following:
HUBwatch for OpenVMSRevision 3.1

If you have not previously installed and used HUBwatch, you will receive 
warning messages like the following, which you can ignore:

(W) Current agent not in the agent table
(W) Unresolved agent node IP name
(W)  Agent type DETMM found for 00.00.00.00

As part of the IVP, HUBwatch software displays the Hub front panel 
window. The Hub front panel window differs, depending on whether you 
started HUBwatch with the IP address of a DEChub 900 MultiSwitch 
(MS), a DECagent 90, or a standalone module. The HUBwatch Use book 
has pictures of the Hub front panel windows that appear for the          
DEChub 900MS and the DECagent 90.

6 Exit the Hub front panel window. Click on the File menu and then click on 
Exit.
Result: The procedure displays the following:
The HUBwatch events viewer will now be verified.

When the HUBwatch viewer window appears on the display, 
move the pointer to the `File` menu, and press and hold 
mouse button 1. Slide the pointer down to `Exit` in the 
menu which will appear below `File`, and release the 
mouse button.

*  Hit the <Return> key to start the events viewer, 
or<ctrl/z> to abort:

$   WATCH /VIEWER
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Task 2: Installing HUBwatch Help Files Separately
If anyone on the system was using OpenVMS help while you were installing HUBwatch, the 
installation did not add HUBwatch help to the OpenVMS help library. To add help for the 
HUBwatch startup command, WATCH/AGENT, at a later time, use the following command:

$ LIBRARY /REPLACE /HELP SYS$HELP:HELPLIB SYS$HELP:HUBWATCH.HLP

Task 3: Editing the System Startup Command Procedure
To start HUBwatch after the installation is complete, you must add the following line to 
SYS$MANAGER:SYSTARTUP_VMS.COM for OpenVMS Version 6.0 or later, :

$ @SYS$STARTUP:HUBWATCH$STARTUP.COM

Task 4: Modifying DECmcc Version 1.2 Files
To launch HUBwatch from DECmcc Version 1.2, all DECmcc users need to modify their own 
MCC_RESOURCE.DAT files according to the instructions in 
MCC_SYSTEM:MCC_HUBWATCH.COM.

Users of POLYCENTER Version 1.3 or later can launch HUBwatch from the POLYCENTER 
Applications menu without editing any files. 

For More Information
See Appendix A for details about using HUBwatch with the POLYCENTER software.

Step Action

7 Press return to verify the events viewer.
Result: The HUBwatch software displays the Events Viewer window.

8 Exit the Events Viewer window. Click on the File menu and then click on 
Exit.
Result: The procedure displays the following:
Exiting HUBwatch

HUBwatch Version 4.1 Installation verification complete.
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Starting HUBwatch as a Standalone Application
Introduction
This section describes how to start HUBwatch for OpenVMS as a standalone application. 
Appendix A describes how to start HUBwatch as an add-on application to the POLYCENTER 
Network Management platform.

HUBwatch Logicals
HUBwatch and the included HUBloader applications use a number of logicals that are set at kit 
installation time.    

Note: The HUBloader application requires that the DEChub Consolidated Firmware kit 
also is installed on your system. 

Command Syntax
Use the following command to start HUBwatch:

$ WATCH/AGENT agent-name  or ip-address /COMMUNITY=comm-string  
_$ /RETRIES= n /TIMEOUT= n /VIEW=logical (or physical) 

Command Use
When you start HUBwatch, you can use all or part of the full startup command. Which you use 
depends on whether you previously used HUBwatch to add entries for the agents you want to 
use to the Agent List box in the Community window. 

For More Information
See SNMP Agents in Chapter 4 for information about adding agent entries.

Logical Description

HUBWATCH_LIBRARY Identifies the directory where the hubwatch agents file 
resides.

HUBWATCH_LOAD Is used by HUBloader to identify the directory where the 
DEChub Consolidated Firmware kit's firmware and 
dcffiles.dat  files are located..

HUBWATCH_HUBLOADER Is used by HUBloader to identify the directory where you 
want to create the status message log and the load from 
agents list files. You need write access to this directory.
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Command Variables
These are the start command variables.

The First Time You Start HUBwatch 
The first time you invoke HUBwatch, the startup command must at least include an agent's IP 
address. 

Example: $ WATCH/AGENT 00.00.00.00

HUBwatch will use default values for the remaining parameters. (The default community name 
is public. If the requested agent has a different community name, you must specify that name.) 

Starting Subsequent HUBwatch Sessions
Once you are running HUBwatch, add entries for the agents you want to use with the Add Agent 
window. Then, you can invoke HUBwatch with the name of an agent from the Agent List box. 

Example: $ WATCH/AGENT HUBMAN

Information About Adding Agents:  See SNMP Agents in Chapter 4.

This Variable... Specifies...

agent-name The name assigned to the agent module 
Example: agent1.

ip-address The Internet address in the form n.n.n.n, n being a decimal number less than 
256.

comm-string The name assigned to the community. When you enter the community 
name, use quotation marks. 
Example: Community="public" .

/RETRIES=n An integer that sets the number of retries allowed.

/TIMEOUT=n The timeout period in seconds.

/VIEW=n Whether a logical or physical view of the hub appears in the Hub front 
panel window. The physical view is the default.
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Initial Display
When you execute the startup command, the Hub front panel window appears. The Hub front 
panel window differs, depending on whether you started HUBwatch with the IP address of a 
DEChub 900 MultiSwitch (MS), a DECagent 90, a GIGAswitch, or a standalone module. The 
HUBwatch Use book has pictures of the DEChub 900MS and DECagent 90 Hub front panel 
windows.

Steps
Complete the following steps to start HUBwatch.

Step Action

1 Is the logical name HUBWATCH$LIBRARY defined as the directory that 
contains or will contain the Agent file, HUBWATCH_AGENTS.DAT?
• If yes, go to step 2.

• If no, define the logical name as the correct directory. See the 
HUBwatch Use book for details.

2 Are you currently using HUBwatch Version 2.0 or earlier?
• If no, go to step 3.

• If yes, make a backup copy of your Agents file before running 
HUBwatch Version 4.1. The first time you add or delete an agent in 
your Agents file, HUBwatch Version 4.1 automatically converts the 
Agents file into a new format. The new format is not compatible with 
earlier versions of HUBwatch. The Agents file is located in 
HUBWATCH$LIBRARY:HUBWATCH_AGENTS.DAT

3 Enter the HUBwatch start command.
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Starting the Poller and the Events Viewer
Introduction
The HUBwatch poller is a background process that queries a list of DEChubs and DEChub 
modules for selected MIB information. This information is then used by the HUBwatch alarms 
component. The events viewer allows you to view this information.

Poller Command Syntax
Use the following command to start the poller:

$ WATCH/POLLER START [/FILE= alarmed-agents-file-name]

Command Variable: The FILE=alarmed-agents-file-name variable tells HUBwatch to read 
the specified file without starting the Alarms Setup window.

Disabling the Poller: To disable the poller, enter the following command:

$ WATCH/POLLER STOP

Events Viewer Command Syntax
Use the following command to start the events viewer:

$ WATCH/VIEWER
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